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Chapter 1: Introduction 

1.1 Purpose 
 
The purpose of this document is to provide a Quide Guide for customers who are using MoCo for SMS 
Appointment Reminders. 
 

1.2 Target Audience 
 
The target audiences of this document are all customers who will be using MoCo for performing SMS 
Appointment Reminders. This includes educational centres, travel agencies,    clubs/ associations/ societies, 
dental/specialist clinics, bridal studios, car serving centres, etc. 
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Chapter 2: Client Database Management 

2.1 Import existing customer database  
 
You can import your existing customer information into MoCo’s Address Book. The import file can be either in 
csv (comma-separated-values) format, or a tab-delimetered file, or a MS Excel file (*.xls). 
 

2.1.1 Prepare Import File (csv/txt) from existing database 
 
To prepare import file (csv/txt) from your existing Microsoft Excel spreadsheet,  
 
Step 1: Open your customer database spreadsheet using MS Excel. 
 
Step 2: From the File menu, select “Save As …” option. 
 
Step 3: A “Save As” dialog box will appear.  
 

 
 
Step 4: Key in the file name to be saved and select the type of file to be saved. For csv file, select “CSV 
(comma-delimited) (*.csv)” as the file type. For tab-delimited file, select “Text (Tab-delimited) (*.txt)” as the 
file type.  
 
Step 5: Click “Save” button. The below warning box may appear. Just click “Yes” button. 
 

 
 
Step 6: The csv / txt file is saved successfully. Close the MS Excel application. 
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2.1.2 Prepare Import File (MS Excel) from existing database 
 
To directly import the address book from a MS Excel sheet, you need to convert the “Mobile Number” field 
(and whatever number fields you have in your database) into a Text field: 
 
Step 1: Open the existing excel file using Microsoft Excel. A sample of the excel file is shown below: 
 

 
 
Step 2: Convert column B (“Raw Mobile”) into TEXT: 
 
2a. Highlight the column (in this case, column B) to be converted. 
 
2b. Select from menu, “Data -> Text to Columns …” option. 
 
2c. The dialog box shown below will be displayed. Click the “Next” button. 
 

 
 
2d. The dialog box shown below will be displayed. Click the “Next” button again. 
 

 
 
2e. The dialog box shown below will be displayed. Select “Text” and click “Finish” button. 
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2.1.3 Configure type of Import file 
 
Before importing the Address Book, you need to select the type of import file that MoCo needs to import.  
 
Step 1: At the MoCo software, select “Configuration Settings”. A dialog box as shown below will appear. 
 

 
 
Step 2: Under “Format for importing address book”, select the type of import file you are going to import into 
MoCo’s address book. For MS Excel file, you will need to specify the SpreadSheet name also. 
 
Step 3: Click “OK” button. 
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2.1.4 Import csv/txt file into MoCo 
 
To import from csv file into address book, 
 
Step 1: From the File menu, click on the Import Address Book 
 
Step 2: From the Open dialog box, select the csv or txt file to import into the database. Click “Open” button. 
 

 
 
Step 3: On the Import Address Book dialog, match and select the correct field of each column. If you do not 
select a field name above the column, that particular column will not be imported. 
 

 
 
 
Step 4: If one of the column of your database contains the name of the contact group, you can select the option 
“Contact Group” for that column. For contacts who are members of multiple contact groups, the contact group 
names are separated by semicolons within the column. 
 

 
 
Step 5: Click Import button to start importing. 
 
Step 6: A dialog box as shown below will appear, displaying the contacts that are imported successfully and 
those that failed.  
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Step 7: To save result of the import process, click “Save Result”. The result is saved into a text document. 
 
Step 8: To proceed with the import process, click “Proceed” button. To abort the import process, click “Cancel” 
button. 
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Chapter 3: Create Message Templates 
 
MoCo’s Template Editor allows user to create reusable SMS messages. Frequently used SMS can be saved as 
template and recalled when needed. User will be able to access the created template by right-clicking of the 
mouse button in all “Message” text boxes, and then choosing from the options “Insert Template” or “Append 
Template” to include a template into the message. 
 
 
To create new templates, 
 

Step 1: Click on  button to clear Template Information area. 
 
Step 2: Enter template information (template name and content) into respective fields.  
 

 
 

Step 3: Click on  to save template. 
 
When a template is created successfully, the template name will appear on the List of Templates box. 
 

3.1 Message Tags 
 
MoCo supports the use of “Message Tags” for creating dynamic message content. 
 

 
 
You can insert message tags into templates by right-clicking of the mouse, and then select “Insert Message Tag” 
to insert the appropriate message tags. 
 
Currently, MoCo supports the use of the following message tags: 
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• Recipient’s Name – This tag shall be used to insert the name of individual recipients at the time of sending. 
• Recipient’s Number – This tag shall be used to insert the mobile phone number of individual recipients at 

the time of sending. 
• Originator’s Name – This tag is only used in the “Forward to selected Recipients” action of the “Automatic 

Response System”. It shall insert the name of the originator of SMS into the message. 
• Originator’s Number – This tag is only used in the “Forward to selected Recipients” action of the 

“Automatic Response System”. It shall insert the mobile number of the originator of SMS into the message. 
• Specific Date – This tag is only used in the Scheduler. It shall insert the specific date of the scheduled SMS 

sending into the message. 
• Specific Time – This tag is only used in the Scheduler. It shall insert the specific time of the scheduled SMS 

sending into the message. 
• Appointment Date – This tag is only used in the Appointment Book. It shall insert the appointment date into 

the message. 
• Appointment Time – This tag is only used in the Appointment Book. It shall insert the appointment time 

into the message. 
• Appointment Name – This tag is only used in the Appointment Book. It shall insert the appointment name 

into the message. 
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Chapter 4: Regular customer callback 
 
MoCo can be used to perform regular customer callback by sending sms to existing customers on products 
which they may be interested.  
 
Taking a private educational centre as an example, a student who had taken a Korean language course may be 
interested in other upcoming language courses that the centre offers.  
 

4.1 Update customer’s information 
 
Taking the example of the educational centre, to perform effective customer recall, you need to keep the MoCo 
Address Book updated.  
 
Step 1: Select the customer to be updated from the List of Contacts. 
 
Step 2: Key in the preferences of the customer in the “Remarks 1” field provided.  
 

 
 

Step 3: Click on  to save the changed information. 
 

4.2 Perform customer recall 
 
Patient recall can be performed as and when you have a new product or service or course that you want to 
introduce to existing customer. The key to performing customer recall is targeted advertising, that is, sending 
out sms that contain information that may be of interest to them. 
 
To perform customer recall, 
 

Step 1: From “Tools” menu, select “Send SMS” option. You can also click the  button on the toolbar 
alternatively. 
 
 
Step 2: A dialog box as shown below will appear. Type in the message you want to send in the message box 
provided. The text on the left indicates the number of characters within the message. For “Normal Text” 
message, one SMS allows 160 characters. For “Unicode (Chinese Text)” message, one SMS allows 70 
characters. If the number of characters exceeds the limit, it shall be broken into multiple SMSes before sending 
out. 
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Step 3: Alternatively, you can select from a list of message templates by right-clicking the mouse inside the 
message box. A context box will appear. Move the mouse to “Insert Template” option to select a pre-defined 
message template. 
 

 
 
Step 4: Select the Message Type of the message you wish to send. If your message contains chinese text, you 
must select “Unicode (Chinese Text)” option. 
 
Step 5: Click the “Advanced” button. 
 
Step 6: The “Advanced Recipient Selection” dialog box will appear. You can select your criteria and perform a 
search to retrieve the relevant customers’ information. 
 

 
 

Step 7: Upon clicking the “Search” button, the result shall be displayed on the lower portion of the dialog box.  
 

 
 
Step 8: Click “Select All” button to select all the contacts retrieved from the search. You can also select a few of 
the contacts by pressing “Ctrl” key and click on their individual names, then click “Selected Contacts” button. 
 
Step 9: Click “Send” button to send the SMS. 
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Chapter 5: Appointment Management 

5.1 Setting up Auto Appt Confirmation 
 
To set up MoCo for Automatic Appointment Confimation, 
 
Step 1: At Auto Response System page, create a new rule: 
 

 
 
Set the sender condition to “All”, and message pattern to “Begin with: Confirm”.  
 
Select the “Confirm/Cancel Appointment” action, with type of message set to “Confirmation”.  
 
Click “Add New Rule” button to add the new rule. 
 

5.2 Configure Appointment Book settings 
To access the Configuration Settings dialog, click on the  icon on the toolbar or select Configuration Settings 
from the Tools menu. 
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On the Appointment Book configuration page, users can configure the following default parameters:  
 

• Default Settings 
 

User can set the default values of : 
 

o Appointment Start / End Time 
o Preferred time to SMS 
o Date for SMS Reminder 
o Priority level 

  
• Send Subsequent SMS Reminders 

 
User can determine how MoCo handle subsequent SMS reminders: 

o Send subsequent reminders irregardless of response – Subsequent SMS reminders shall be 
sent out no matter the recipients reply back or not 

 
o Send subsequent reminders to confirmed recipients only – Subsequent SMS reminders shall 

only be sent out if the recipients confirmed their appointments (either manually or 
automatically) 

 
o Do not send reminders to confirmed / cancelled recipients – Subsequent SMS reminders shall 

not be sent out if the recipients has confirmed or cancelled their appointments (either manually 
or automatically) 

  
• Automatically insert appointment name 

 
Upon creation of new appointment in the MoCo’s Appointment Book, an appointment name has to be 
given. To auto fill the appointment name, check the box “Automatically Insert Appointment Name” and 
type the name given to each appointment. MoCo will use this name and append a running number at the end 
to make each appointment name unique. 
 
• Multiple Appointment Book Configuration 

 

 
 

By clicking the “Multi-Appt Book Configuration” button, the above dialog box will appear for you to add / 
delete / update appointment books. 

 

5.3 Adding, Deleting and Updating Appointment 

5.3.1 Add new Appointment  
 
To add a new appointment,  
 
Step 1: Select the Appointment Book within which you wish to add new appointment.  

 
 

 - 15 - 



Step 2: Double click on the screen calendar date that you want to create the appointment. A dialog box for 
adding new appointment will appear. 
 
Step 3: Enter information for the appointment. 
 

 
 
• Appointment Name - Appointment name will be used to confirm appointment when recipient reply with 

SMS message.If the Config Setting for Automatically Insert Appointment Name is set, the appointment 
name will be auto filled by MoCo. 

• Priority – You can select from low, medium, high and very high. This is only a color highlight for the 
appointment subject when you look at the main calendar. 

• Subject – A brief description of the appointment. The subject text will be displayed on the main calendar. 
• Start / End Time – The appointment start and end time. Note that the appointment start time can be 

automatically inserted into the SMS content using message tag <<Appt Time>>. 
• Remarks – Additional (optional) remarks. 
• SMS Reminder – Click this checkbox to enable sending of SMS reminder. 
• Recipients/Advanced – Select the recipients for the appointment reminder SMS. You can select from a list 

of contacts/contact groups (using Recipient button), or via querying the Address Book (using Advanced 
button). 

• 1st/2nd/3rd SMS Reminder – Click this checkbox to enable sending of first/second/third SMS reminder. 
• Preferred time to SMS – The preferred time to send out reminder SMS. You can set the number of 

days/weeks before the actual appointment date to send the reminder sms. 
• Message Type – Select from Normal Text, 8-Bit Data and Unicode (Chinese Text). For normal english sms, 

choose Normal Text. For content containing chinese text, choose Unicode. 
• Message Content – Actual message content to be sent. You can insert template or type in directly.  
 

Step 4: Click on  to create appointment. 
 
 
When an appointment is created successfully, the appointment’s start date, end date and subject will appear on 
the main calendar. 
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5.3.2 Delete Appointment 
 
To delete an appointment, 
 
Step 1: From the calender view, double click on the appointment entry to be deleted. Alternatively,  from the 
Appointment dialog, select the appointment to delete from List of Appointments. 
 

Step 2: Click on  to delete the highlight appointment. 
 

5.3.3 Updating Appointment 
 
To update an appointment, 
 
Step 1: From the calender view, double click on the appointment entry to be updated. Alternatively,  from the 
Appointment dialog, select the appointment to update from List of Appointments. 
  
Step 2: Replace the information to be updated. 
 

Step 3: Click on  to save the changed information. 
 

5.3.4 Changing Appointment Date 
 
To change an appointment, 
 
Step 1: From the calender view, double click on the appointment entry to be updated. Alternatively,  from the 
Appointment dialog, select the appointment you wish to change date of from the List of Appointments. 
 

Step 2: Click on  to change the appointment’s date. 
 
Step 3: A dialog box shown below will appear. Enter the new Appointment Book name, Appointment Date, 
Appointment Start and End Time. Then click “Ok”. 
 

 
 

5.4 Check Response 
 
To check a confirmation response, 
 
Step 1: Double click on the appointment. 
 

Step 2: Click on  to open the response dialog. Check under the Response column for result. 
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Upon right-clicking on the appointment recipient’s name, a context box appear displaying the following options: 
 

• Reply to Sender – Select this option to invoke a dialog box for you to send sms reply to the sender. 
• Confirm Appointment – Do a manual appointment confirmation. This option is useful if the customer 

confirm his appointment via phone call or other means instead of sms. 
• Cancel Appointment – Do a manual appointment cancellation. This option is useful if the customer 

cancel his appointment via phone call or other means instead of sms. 
 
To save the response information into a HTML report, just click “Save Response to HTML” button. 
 

5.4.1 Do manual Appt Confirmation at Transaction Manager 
 

 
 
The following options are available when you right-click on any records in the Transaction Manager InBox: 
 
• Reply to Sender – A dialog box will appear for you to send reply to the selected sender. 
• Forward message – A dialog box will appear for you to forward the message to other recipients. 
• Delete Records – Use this option to delete one or more records. Alternatively, you can use the “Delete” key 

to perform deletion. 
• Confirm / Cancel Appointment – A dialog box will appear, displaying a list of appointments of the sender. 
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 To confirm/cancel any appointment, just click on the item and then click “Confirm Appointment” or 

“Cancel Appointment” buttons. This feature is useful in updating the Appointment Book when customers 
make appointment confirmation via phone call rather than sms.  

 
 

5.5 View Appointment History 
 

Step 1: Click on . A dialog box will appear for you to view appointment history. 
 
Step 2: Select the name of the contact. Click the Search button. 
 

 
 

Step 3: To save the appointment history to file, click “Export to File” button. 

5.6 Import Appointment List 
 

Step 1: Click the . An Open File dialog box will appear for you to load to Appointment list file. MoCo 
expects a csv (comma-separated-values) file for importing appointment. 
 

 
 
A typical Appointment Import file (*.csv) should contain the following fields (not in any order): 
• Customer Name 
• Customer Mobile Number 
• Appointment Start Time (in 24-hour format HH:MM) 
• Appointment Book Name (Optional) 
• Appointment Duration in minutes (Optional) 
 
All records within a single Appointment Import file should belong to the same appointment date. Each of these 
fields shall be separated by a comma, and each record separated by a carriage return. 
 
 
Step 2: Upon selecting the Appointment Import file (*.csv), a dialog box as shown below will appear, displaying 
all the columns within the import file. 
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Step 3: Select the field names (Eg. Recipient Name, Appt. Book Name, etc) for the columns that you wish to 
import. 
 
Step 4: At the “General Appointment Information” portion on the left, enter the following information: 
 

• Appointment Date – The appointment date for the appointments to be imported. 
• Default Priority – Priority level of the appointments to be imported. You can use the default value. 
• Duration – The appointment duration in minutes. If your appointment import file does not contain any 

information on appointment duration, you can set a standard duration here for all the appointments to 
be imported. 

• Preferred SMS Time – The time and number of days/weeks before appointment which you wish to 
send out SMS. 

• Message Type – Select from Normal Text, 8-Bit Data or Unicode (Chinese Text). For normal english 
content, use Normal Text. If content contains chinese characters, use Unicode. 

• Message Content – The actual message content to be send out via SMS. You can insert template here 
or key in the text directly. 

 
Step 5: Under the “Import Process Logger” portion, you can save a report of the import process of checking 
“Save import process report” checkbox. You can also specify the folder which you wish to save the import 
process report. 
 
Step 6: Once all the information are checked to be correct, you can click the “Import” button to proceed with the 
import process. Upon successful import, you will see the below message box. 
 

 
 
 

5.7 Print Appointment List 
 
MoCo allows user to perform print appointment list on standard A4 paper.  
 
To perform appointment printing, select “Print Appointment Book” from the File menu. A dialog box as shown 
below will appear. 
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Step 1: Select the appointment book name which you wish to print. 
 
Step 2: Select the starting/ending dates of appointments to print. 
 
Step 3: Select the priority level of appointments to be printed. 
 
Step 4: Click Print. A Print dialog box as shown below will appear. 
 

 
 
Step 5: Select the appropriate printer name. Click “Properties” button to set the paper size. 
 

 
 
Step 6: A dialog box as shown above will appear. Note that for different printer, a different kind of dialog will 
appear. 
 
Step 7: Go to Page Setup and set the Page Size to “A4”.  
 
Step 8: Click “OK”. You will return to the previous Print dialog box. 
 
Step 9: Click “OK” to proceed with the printing. 
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